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Chapter 179

Non-Inferiority Tests
for the Generalized
Odds Ratio for
Ordinal Data in a 2x2
Cross-Over Design
Introduction
Senn (2002) defines a cross-over design as one in which each subject receives all treatments and the objective is
to study differences among the treatments. The name cross-over comes from the most common case in which
there are only two treatments. In this case, each subject crosses over from one treatment to the other. It is assumed
that there is a washout period between treatments during which the response returns back to its baseline value. If
this does not occur, there is said to be a carry-over effect.
A 2×2 cross-over design contains to two sequences (treatment orderings) and two time periods (occasions). One
sequence receives treatment A followed by treatment B. The other sequence receives B and then A. The design
includes a washout period between responses to make certain that the effects of the first drug do not carry over to
the second. Thus, the groups in this design are defined by the sequence in which the drugs are administered, not
by the treatments they receive. Indeed, higher-order cross-over designs have been used in which the same
treatment is used at both occasions.
Cross-over designs are employed because, if the no-carryover assumption is met, treatment differences are
measured within a subject rather than between subjects—making a more precise measurement. Examples of the
situations that might use a cross-over design are the comparison of anti-inflammatory drugs in arthritis and the
comparison of hypotensive agents in essential hypertension. In both cases, symptoms are expected to return to
their usual baseline level shortly after the treatment is stopped.
The sample size calculations in the procedure are based on the formulas presented in Lui (2016).

Advantages of Cross-Over Designs
A comparison of treatments on the same subject is expected to be more precise. The increased precision often
translates into a smaller sample size. Also, patient enrollment into the study may be easier because each patient
will receive both treatments. Finally, it is often more difficult to obtain a subject than to obtain a measurement.
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Disadvantages of Cross-Over Designs
The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires
additional assumptions. It may be difficult to separate the treatment effect from the period effect, the carry-over
effect of the previous treatment, and the interaction between period and treatment.
The design cannot be used when the treatment (or the measurement of the response) alters the subject
permanently. Hence, it should not be used to compare treatments that are intended to provide a cure.
Because subjects must be measured at least twice, it is often more difficult to keep patients enrolled in the study.
It is arguably simpler to measure a subject once than to obtain their measurement twice. This is particularly true
when the measurement process is painful, uncomfortable, embarrassing, or time consuming.

Technical Details
The 2×2 crossover design may be described as follows. Randomly assign the subjects to one of two sequence
groups so that there are 𝑛𝑛1 subjects in sequence one and 𝑛𝑛2 subjects in sequence two. In order to achieve design
balance, the sample sizes 𝑛𝑛1 and 𝑛𝑛2 are assumed to be equal so that 𝑛𝑛1 = 𝑛𝑛2 = 𝑛𝑛 = 𝑁𝑁/2.
Sequence one is given the control (A) followed by the treatment (B). Sequence two is given the treatment (B)
followed by the control (A).

Cross-Over Design
The discussions that follow summarize the results in Lui (2016) on pages 57-70. Consider a 2×2 cross-over design
(𝑔𝑔)

and let 𝑌𝑌𝑖𝑖𝑖𝑖 represent the response category for the jth subject, j = 1, …, ng, in the ith period (i = 1, 2), in sequence

g (g = 1, 2) on an ordinal scale with L possible categories, 𝐶𝐶1 < 𝐶𝐶2 < 𝐶𝐶3 < ⋯ < 𝐶𝐶𝐿𝐿 . Assume that subjects in
sequence 1 are given the control or standard in period 1 and then the experimental treatment in period 2. Assume
that subjects in sequence 2 are given the experimental treatment in period 1 and then the control or standard in
period 2. If we define 𝜂𝜂 as the relative effect of the treatment to the control, then 𝜂𝜂 > 0 indicates that the response
category, 𝐶𝐶𝑘𝑘 , of a subject receiving the treatment tends to be greater than the response category of a subject
receiving the control or standard. Similarly, 𝜂𝜂 < 0 indicates that the response category, 𝐶𝐶𝑘𝑘 , of a subject receiving
the treatment tends to be less than the response category of a subject receiving the control or standard.
For a randomly selected subject from sequence g (g = 1, 2), the probability that the measured response in period
(𝑔𝑔)

(𝑔𝑔)

1, 𝑌𝑌1𝑗𝑗 , is less than the measured response in period 2, 𝑌𝑌2𝑗𝑗 , is
(𝑔𝑔)
Π𝐶𝐶
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(𝑔𝑔)
𝑌𝑌2𝑗𝑗 �

𝐿𝐿−1

𝐿𝐿

(𝑔𝑔)

= � � 𝜋𝜋𝑟𝑟𝑟𝑟

(𝑔𝑔)

𝑟𝑟=1 𝑠𝑠=𝑟𝑟+1

𝜋𝜋𝑟𝑟𝑟𝑟 = 𝑃𝑃 �𝑌𝑌1𝑗𝑗 = 𝐶𝐶𝑟𝑟 , 𝑌𝑌2𝑗𝑗 = 𝐶𝐶𝑠𝑠 � with r = 1, 2, …, L and s = 1, 2, …, L.
(𝑔𝑔)

Similarly, the probability that the measured response in period 1, 𝑌𝑌1𝑗𝑗 , is greater than the measured response in
(𝑔𝑔)

period 2, 𝑌𝑌2𝑗𝑗 , is

(𝑔𝑔)
Π𝐷𝐷

=
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>
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𝑟𝑟=2 𝑠𝑠=1
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The generalized odds ratio, 𝐺𝐺𝐺𝐺𝐺𝐺(𝑔𝑔) , of subject responses between periods 1 and 2 for a randomly-selected subject
from group g is defined as
𝐺𝐺𝐺𝐺𝐺𝐺 (𝑔𝑔) =

(𝑔𝑔)

Π𝐶𝐶

(𝑔𝑔)

Π𝐷𝐷

.

The generalized odds ratio, 𝐺𝐺𝐺𝐺𝐺𝐺, for the treatment versus the control is then
𝐺𝐺𝐺𝐺𝐺𝐺 (1)
𝐺𝐺𝐺𝐺𝐺𝐺 = 𝑒𝑒 𝜂𝜂 = �
.
𝐺𝐺𝐺𝐺𝑅𝑅 (2)

Non-Inferiority Test Statistics
Higher Values Better
When higher values are better, the null and alternative hypotheses for a one-sided non-inferiority test are
𝐻𝐻0 : 𝐺𝐺𝐺𝐺𝐺𝐺 ≤ 𝐺𝐺𝐺𝐺𝐺𝐺0 vs 𝐻𝐻𝐴𝐴 : 𝐺𝐺𝐺𝐺𝐺𝐺 > 𝐺𝐺𝐺𝐺𝐺𝐺0

where 𝐺𝐺𝐺𝐺𝐺𝐺0 is the lower non-inferiority bound (i.e. the smallest generalized odds ratio for which the treatment
will still be considered non-inferior to the standard or control). When higher values are better, 𝐺𝐺𝑂𝑂𝑂𝑂0 should be
less than one.
The power and sample size calculations are based on the test statistic
𝑍𝑍 =

� � − log(𝐺𝐺𝑂𝑂𝑂𝑂0 )
log�𝐺𝐺𝐺𝐺𝐺𝐺
� ��
� �log�𝐺𝐺𝐺𝐺𝐺𝐺
�𝑉𝑉𝑉𝑉𝑉𝑉

which is asymptotically distributed as standard normal under the null hypothesis with
2

� (𝑔𝑔) + Π
� 𝐷𝐷(𝑔𝑔)
1
Π
� �� = � 𝐶𝐶
� �log�𝐺𝐺𝐺𝐺𝐺𝐺
𝑉𝑉𝑉𝑉𝑉𝑉
.
4
� (𝑔𝑔) Π
� (𝑔𝑔)
𝑛𝑛𝑔𝑔 Π
𝑔𝑔=1

𝐶𝐶

𝐷𝐷

The null hypothesis is rejected in favor of the alternative at level 𝛼𝛼 if
𝑍𝑍 > 𝑍𝑍1−𝛼𝛼

where 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution.

Higher Values Worse

When higher values are worse, the null and alternative hypotheses for a one-sided non-inferiority test are
𝐻𝐻0 : 𝐺𝐺𝐺𝐺𝐺𝐺 ≥ 𝐺𝐺𝐺𝐺𝐺𝐺0 vs 𝐻𝐻𝐴𝐴 : 𝐺𝐺𝐺𝐺𝐺𝐺 < 𝐺𝐺𝐺𝐺𝐺𝐺0

where 𝐺𝐺𝐺𝐺𝐺𝐺0 is the upper non-inferiority bound (i.e. the largest generalized odds ratio for which the treatment will
still be considered non-inferior to the standard or control). When higher values are worse, 𝐺𝐺𝐺𝐺𝐺𝐺0 should be greater
than one.
The power and sample size calculations are based on the test statistic
𝑍𝑍 =

� � − log(𝐺𝐺𝑂𝑂𝑂𝑂0 )
log�𝐺𝐺𝐺𝐺𝐺𝐺
� ��
� �log�𝐺𝐺𝐺𝐺𝐺𝐺
�𝑉𝑉𝑉𝑉𝑉𝑉
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which is asymptotically distributed as standard normal under the null hypothesis with
2

� (𝑔𝑔) + Π
� 𝐷𝐷(𝑔𝑔)
Π
1
� �� = � 𝐶𝐶
� �log�𝐺𝐺𝐺𝐺𝐺𝐺
.
𝑉𝑉𝑉𝑉𝑉𝑉
4
� (𝑔𝑔) Π
� (𝑔𝑔)
𝑛𝑛𝑔𝑔 Π
𝐶𝐶

𝑔𝑔=1

𝐷𝐷

The null hypothesis is rejected in favor of the alternative at level 𝛼𝛼 if
𝑍𝑍 < 𝑍𝑍𝛼𝛼

where 𝑍𝑍𝛼𝛼 is the lower 𝛼𝛼 percentile of the standard normal distribution.

Non-Inferiority Power Calculations

� is the estimate of the generalized odds ratio, then 𝜂𝜂̂ = log�𝐺𝐺𝐺𝐺𝐺𝐺
� � has asymptotic variance
If 𝐺𝐺𝐺𝐺𝐺𝐺
� �� =
𝑉𝑉𝑉𝑉𝑉𝑉 �log�𝐺𝐺𝐺𝐺𝐺𝐺

where
� �� =
𝑉𝑉 �log�𝐺𝐺𝐺𝐺𝐺𝐺

2
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� ��
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,
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1
Π + Π𝐷𝐷
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Also define the standard deviation of log(generalized odds ratio) as
� ��
𝑆𝑆𝑆𝑆 = �𝑉𝑉 �log�𝐺𝐺𝐺𝐺𝐺𝐺

Higher Values Better
Derived from the sample size formula given in Lui (2016) on page 68, the power for the one-sided non-inferiority
test of 𝐻𝐻0 : 𝐺𝐺𝐺𝐺𝐺𝐺 ≤ 𝐺𝐺𝐺𝐺𝐺𝐺0 versus 𝐻𝐻𝐴𝐴 : 𝐺𝐺𝐺𝐺𝐺𝐺 > 𝐺𝐺𝐺𝐺𝐺𝐺0 is
Φ�

log(𝐺𝐺𝐺𝐺𝐺𝐺1 ) − log(𝐺𝐺𝑂𝑂𝑂𝑂0 )
− 𝑍𝑍1−𝛼𝛼 �
𝑆𝑆𝑆𝑆
√𝑛𝑛

where Φ() is the standard normal distribution function, 𝐺𝐺𝐺𝐺𝐺𝐺1 is the actual value of the generalized odds ratio
under the alternative hypothesis, and 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution. The
sample size calculation formula is
2

Higher Values Worse

�𝑍𝑍1−𝛼𝛼 + 𝑍𝑍1−𝛽𝛽 �𝑆𝑆𝑆𝑆
𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 ��
� �.
log(𝐺𝐺𝐺𝐺𝐺𝐺1 ) − log(𝐺𝐺𝐺𝐺𝐺𝐺0 )

Derived from the sample size formula given in Lui (2016) on page 68, the power for the one-sided non-inferiority
test of 𝐻𝐻0 : 𝐺𝐺𝐺𝐺𝐺𝐺 ≥ 𝐺𝐺𝐺𝐺𝐺𝐺0 versus 𝐻𝐻𝐴𝐴 : 𝐺𝐺𝐺𝐺𝐺𝐺 < 𝐺𝐺𝐺𝐺𝐺𝐺0 is
Φ�

log(𝐺𝐺𝐺𝐺𝐺𝐺0 ) − log(𝐺𝐺𝐺𝐺𝐺𝐺1 )
+ 𝑍𝑍𝛼𝛼 �
𝑆𝑆𝑆𝑆
√𝑛𝑛
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where Φ() is the standard normal distribution function, 𝐺𝐺𝐺𝐺𝐺𝐺1 is the actual value of the generalized odds ratio
under the alternative hypothesis, and 𝑍𝑍𝛼𝛼 is the lower 𝛼𝛼 percentile of the standard normal distribution. The sample
size calculation formula is
2

�𝑍𝑍1−𝛼𝛼 + 𝑍𝑍1−𝛽𝛽 �𝑆𝑆𝑆𝑆
𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 ��
� �.
log(𝐺𝐺𝑂𝑂𝑂𝑂0 ) − log(𝐺𝐺𝐺𝐺𝐺𝐺1 )

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment that has already been run.
Select Effect Size (GOR1) when you want to calculate the minimum effect size that can be detected for a
particular design.

Test
Higher Values Are
Use this option to specify the direction of the test.
If Higher Values are “Better”, the alternative hypothesis is H1: GOR > GOR0.
If Higher Values are “Worse”, the alternative hypothesis is H1: GOR < GOR0.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
n (Sample Size per Sequence)
This is the sample size of each sequence or group (AB and BA) in the cross-over design. The individual sequence
sample sizes are assumed to be equal such that the total sample size is equal to N = 2n.
You can enter a single value such as 50 or a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.

Effect Size – Generalized Odds Ratio for
Treatment/Control
OR0 (Non-Inferiority Generalized Odds Ratio)
Specify the non-inferiority generalized odds ratio for treatment versus control.
When higher values are “Better”, the non-inferiority generalized odds ratio is the smallest generalized odds ratio
for which the treatment will still be considered non-inferior to the standard or control.
When higher values are “Worse”, the non-inferiority generalized odds ratio is the largest generalized odds ratio
for which the treatment will still be considered non-inferior to the standard or control.
You can enter a single value such as 0.8 or a series of values such as 0.8 0.85 0.9 or 0.8 to 0.9 by 0.05 in the range
GOR0 > 0, GOR0 ≠ GOR1. When higher values are “Better”, GOR0 should be less than one. When higher values
are “Worse”, GOR0 should be greater than one.
OR1 (Actual Generalized Odds Ratio)
Specify the actual generalized odds ratio for treatment versus control at which power is calculated.
You can enter a single value such as 1 or a series of values such as 1 1.5 2 or 1 to 2 by 0.5 in the range GOR1 > 0,
GOR1 ≠ GOR0. When higher values are “Better”, GOR1 should be greater than GOR0. When higher values are
“Worse”, GOR1 should be less than GOR0.
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Effect Size – Standard Deviation of
Log(Generalized Odds Ratio)
Standard Deviation Estimation Method
Choose how the standard deviation of the log generalized odds ratio (SD) will be estimated.
The options are
•

Enter SD Directly
Input log generalized odds ratio SD values directly. This option allows you to input any value for SD,
regardless of how it was estimated.

•

Use Estimated Cumulative Proportions
Input cumulative proportions from a previous 2x2 cross-over study. These estimates are used only to calculate
the standard deviation and are not necessarily related to the value used for GOR1.

Standard Deviation (SD)
Enter a value for the standard deviation of the log generalized odds ratio, SD.
Estimating SD using Previously-Estimated Discordant Cell Proportions
The standard deviation may be estimated using cumulative proportions from a previous study using the method of
Lui (2016) on page 67, where
SD = √[ (1/4) * Σg[ (∏C(g) + ∏D(g)) / (∏C(g) * ∏D(g)) ] ].
PASS will calculate the SD for you using this method if you set Estimation Method to “Use Estimated
Cumulative Proportions” and enter cumulative proportions from a previous 2x2 cross-over study.
Cumulative Proportions
Enter the corresponding cumulative proportion from a previous 2x2 cross-over study.
The estimated proportions are defined as follows:
Sequence 1 = C → T
Sequence 2 = T → C
∏C(g) = Proportion of (Response from Period 1 < Response from Period 2) in Sequence g
∏D(g) = Proportion of (Response from Period 1 > Response from Period 2) in Sequence g
The standard deviation of the log generalized odds ratio is calculated by PASS as described in Lui (2016) on page
67 as
SD = √[ (1/4) * Σg[ (∏C(g) + ∏D(g)) / (∏C(g) * ∏D(g)) ] ].
These estimates are used only to calculate the standard deviation of the log generalized odds ratio and are not
necessarily related to the value used for GOR1.
Range: 0 < ∏C(g) < 1, 0 < ∏D(g) < 1, ∏C(g) + ∏D(g) ≤ 1
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Example 1 – Power Analysis
Suppose you want to consider the power of a non-inferiority test of the hypotheses 𝐻𝐻0 : 𝐺𝐺𝐺𝐺𝐺𝐺 ≤ 0.8 versus
𝐻𝐻𝐴𝐴 : 𝐺𝐺𝐺𝐺𝐺𝐺 > 0.8 in a balanced cross-over design with ordinal data where the test is computed based on the
generalized odds ratio for sequence sample sizes between 25 and 125. Let’s assume that the actual generalized
odds ratio to detect is 2 and the estimated standard deviation of the log generalized odds ratio is 2.5. The
significance level is 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Inferiority Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 CrossOver Design procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on
Non-Inferiority, and then clicking on Non-Inferiority Tests for the Generalized Odds Ratio for Ordinal Data
in a 2x2 Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 1 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For .......................................................... Power
Higher Values Are............................................. Better
Alpha ................................................................. 0.05
n (Sample Size per Sequence) ......................... 25 to 125 by 25
GOR0 (Non-Inferiority Gen. Odds Ratio).......... 0.8
GOR1 (Actual Gen. Odds Ratio) ...................... 2
Estimation Method ............................................ Enter SD Directly
Standard Deviation (SD) ................................... 2.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Non-Inferiority Test ───────────────────────────────────────────
H0: GOR ≤ GOR0 vs. H1: GOR > GOR0

Power
0.57445
0.82813
0.93690
0.97832
0.99291

Sequence
Sample
Size
n
25
50
75
100
125

Total
Sample
Size
N
50
100
150
200
250

Non-Inf.
Gen.
Odds
Ratio
GOR0
0.800
0.800
0.800
0.800
0.800

Actual
Gen.
Odds
Ratio
GOR1
2.000
2.000
2.000
2.000
2.000

Standard
Deviation
SD
2.500
2.500
2.500
2.500
2.500

Alpha
0.050
0.050
0.050
0.050
0.050

References
Lui, Kung-Jong. 2016. Crossover Designs: Testing, Estimation, and Sample Size. John Wiley & Sons Ltd.
Chichester, West Sussex, England.
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
n is the sample size in each sequence (or group).
N is the total combined sample size from both sequences.
GOR0 is the non-inferiority generalized odds ratio used to specify the hypothesis test.
GOR1 is the actual generalized odds ratio at which power is calculated.
SD is the user-entered standard deviation of log generalized odds ratio. This is estimated from a previous
study.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
For a 2x2 cross-over design, a sample size of 25 in each sequence for a total of 50 achieves
57.445% power to detect a generalized odds ratio of 2.000 using a one-sided non-inferiority
test against a bound of 0.800 with a significance level of 0.050 when the standard deviation is
2.500.
Dropout-Inflated Sample Size ────────────────────────────────────────────────────

Dropout Rate
20%
20%
20%
20%
20%

── Sample Size ──
n
N
25
50
50
100
75
150
100
200
125
250

Dropout-Inflated
Enrollment
── Sample Size ──
n'
N'
32
64
63
126
94
188
125
250
157
314

Expected
Number of
── Dropouts ──
d
D
7
14
13
26
19
38
25
50
32
64

Definitions
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the
course of the study and for whom no response data will be collected (i.e. will be treated as “missing”).
n and N are the evaluable group and total sample sizes, respectively, at which power is computed (as entered
by the user). If n subjects from each group are evaluated out of the n' subjects that are enrolled in the
study, the design will achieve the stated power. N = 2n.
n' and N' are the number of subjects that should be enrolled in the study in order to end up with n and N
evaluable subjects, based on the assumed dropout rate. n' is calculated by inflating n using the formula n'
= n / (1 - DR), with n' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J.,
and Wang, H. (2008) pages 39-40.). N' = 2n'.
d and D are the expected number of group and total dropouts, respectively. d = n' - n and D = 2d.

179-9
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Non-Inferiority Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 Cross-Over Design

Charts Section

This report shows the values of each of the parameters, one scenario per row. This plot shows the relationship
between sample size and power. We see that a sample size of just under 50 per sequence is required to detect a
generalized odds ratio of 2 with 80% power.
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Example 2 – Calculating Sample Size when Estimating the
Standard Deviation from a Previous Study (Validation using Hand
Calculations)
This example demonstrates how to calculate the sample size when estimating the standard deviation of the log
generalized odds ratio from data in a previous study using the method in Lui (2016) on page 67. In this example
we’ll find the sample size required to detect a generalized odds ratio of 2 with 80% power at a significance level
of 0.05 in a non-inferiority test against a lower generalized odds ratio bound of 0.8. The SD is estimated from
cumulative proportions from a previous study.
Suppose the cumulative proportions are
(1)

Π𝐶𝐶 = 0.11
(1)

Π𝐷𝐷 = 0.29
(2)

Π𝐶𝐶 = 0.23
(2)

Π𝐷𝐷 = 0.11

Using the method of Lui (2016) on page 67, SD is calculated as
2

(𝑔𝑔)

(𝑔𝑔)

Π + Π𝐷𝐷
1
𝑆𝑆𝑆𝑆 = � � 𝐶𝐶 (𝑔𝑔) (𝑔𝑔)
4
Π Π
𝑔𝑔=1

𝐶𝐶

𝐷𝐷

1 0.11 + 0.29 0.23 + 0.11
+
�
=� �
0.23(0.11)
4 0.11(0.29)

= 𝟐𝟐. 𝟓𝟓𝟓𝟓𝟓𝟓𝟓𝟓

PASS will calculate this SD value for you automatically when you input the cumulative proportions.
Since there is no example given for this calculation in the book, we’ll validate this procedure using hand
calculations. The sample size calculated by hand using the equation on Lui (2016) page 68 is
2

2

(1.645 + 0.842)2.5484
�𝑍𝑍1−𝛼𝛼 + 𝑍𝑍1−𝛽𝛽 �𝑆𝑆𝑆𝑆
𝑛𝑛 = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 ��
� � = 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶 ��
� �
log(𝐺𝐺𝐺𝐺𝐺𝐺1 ) − log(𝐺𝐺𝐺𝐺𝐺𝐺0 )
log(2) − log(0.8)

= 𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶𝐶{47.8240}
= 48
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Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Inferiority Tests for the Generalized Odds Ratio for Ordinal Data in a 2x2 CrossOver Design procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on
Non-Inferiority, and then clicking on Non-Inferiority Tests for the Generalized Odds Ratio for Ordinal Data
in a 2x2 Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 2 by
going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For .......................................................... Sample Size
Higher Values Are............................................. Better
Power ................................................................ 0.80
Alpha ................................................................. 0.05
GOR0 (Non-Inferiority Gen. Odds Ratio).......... 0.8
GOR1 (Actual Gen. Odds Ratio) ...................... 2
Estimation Method ............................................ Use Estimated Cumulative Proportions
∏C(1) ................................................................ 0.11
∏D(1) ................................................................ 0.29
∏C(2) ................................................................ 0.23
∏D(2) ................................................................ 0.11

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a Non-Inferiority Test ───────────────────────────────────────────
H0: GOR ≤ GOR0 vs. H1: GOR > GOR0

Power
0.80128

Sequence
Sample
Size
n
48

Total
Sample
Size
N
96

Non-Inf.
Gen.
Odds
Ratio
GOR0
0.800

Actual
Gen.
Odds
Ratio
GOR1
2.000

Standard
Deviation
SD*
2.548

Alpha
0.050

* SD Estimated using Previously-Estimated Cumulative Proportions:
∏C(1) = 0.11, ∏D(1) = 0.29, ∏C(2) = 0.23, ∏D(2) = 0.11

This report indicates that the estimated standard deviation using the method of Lui (2016) is 2.548 and the
required sample size is 48 per sequence. The cumulative proportions are also listed. These values for SD and n
computed by PASS match our hand calculations above.
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